
SIMATIC

Process Control System PCS 7
PCS 7 Readme V8.0 including 
Update 1

Readme

Version: 2012-07-11 (ONLINE)

 
07/2012
A5E03759369-03

Security information
 1

 

Overview
 2

 

Notes on Installation
 3

 

Notes on Usage
 4

 

Software components on the 
SIMATIC PCS 7 DVD V8.0 
including Update 1 and 
changes to PCS 7 V8.0

 

5



Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.
 

 
CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

 

 
NOTICE
indicates that an unintended result or situation can occur if the relevant information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

A5E03759369-03
Ⓟ 07/2012 Technical data subject to change

Copyright © Siemens AG 2012.
All rights reserved
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Security information 1
Siemens offers IT security mechanisms for its automation and drive product portfolio in order 
to support the safe operation of the plant/machine. Our products are also continuously 
developed further with regard to IT security. 

We therefore recommend that you keep yourself informed about updates and upgrades for 
our products and always use the latest version of each product. You can find information on 
this at: 

http://support.automation.siemens.com. 

You can register for a product-specific newsletter here.

For the safe operation of a plant/machine, however, it is also necessary to integrate the 
automation components into an overall IT security concept for the entire plant/machine, which 
corresponds to the state-of-the-art IT technology. You can find information on this at: 

http://www.siemens.com/industrialsecurity.

Products used from other manufacturers should also be taken into account here.
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Overview 2
 

 Note
Notes on the documentation

Please read these notes carefully; they contain information that will be important to you and 
upgrades to PCS 7.

The information given in this Readme file takes precedence over all the PCS 7 manuals.
 

You have received the software package, SIMATIC PCS 7 V8.0 incl. Update 1. SIMATIC PCS 
7 is the future-oriented process control system used in the "Totally Integrated Automation" 
concept by Siemens.

● Based on robust, industrial standard SIMATIC hardware and software components

● Modern, distributed client/server architecture

● Simple and quick system expansion and optimization in runtime

● Scalable from a small laboratory system to networks of plants with 60,000 process tags

● For all applications: continuous and batch applications

● For all industries: process, production and hybrid sectors

● Efficient, plant-wide engineering

● Flexible and simple integration of field devices and drives based on PROFIBUS

● Homogeneously integrated safety technology, certified by the TÜV (German Technical 
Inspectorate)

● Openness at all levels

● Increased availability through redundancy at all levels

● Modular structured and scalable batch system, SIMATIC BATCH

● Flexible route control system, SIMATIC Route Control

● 21 CFR Part 11 compliance

We hope that you enjoy using SIMATIC PCS 7 and have great success with it.

Your PCS 7 team

PCS 7 Readme V8.0 including Update 1
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Notes on Installation 3
3.1 General information

The text below contains important basic information about installing control engineering 
products. Each of the products comes with product-specific information in the form of readme 
files. 

The information contained in these readme files also applies to using products in PCS 7. You 
can find additional information on PCS 7 in the Internet at:

● PCS 7 website (https://www.siemens.com/PCS7) 

You can find SIMATIC Customer Support in the Internet at:

● Service & support portal (http://www.siemens.com/automation/service&support) 

Electronic manuals and information on PCS 7
Once you have installed PCS 7 on your computer, the following PCS 7 documentation is 
available:

● You can find this documentation in the section SIMATIC > Documentation or the product 
information in the Start menu of Windows:

– PCS 7 - Catalog Overview (PDF)

– PCS 7 - Operating Instructions - OS Process Control (PDF)

– PCS 7 - Installation Manual - PC Configuration and Authorization (PDF)

– PCS 7 - Configuration Manual - Engineering System (PDF)

– PCS 7 - Configuration Manual - Operator Station (PDF)

If you do not wish to install this documentation, you can also view it at any time on the SIMATIC 
PCS 7 DVD 1/2 in the folder "_Manuals\English" or "_Product_Information\English". 

The complete PCS 7 documentation is available in multiple languages at the following Internet 
site:

● Link to the PCS 7 manuals (www.siemens.com/pcs7-documentation)
 

 Note
Notes on the documentation

Documents available online may be more up-to-date than the version of documents installed 
with PCS 7 Setup. The statements in documents available online should therefore be given 
priority over installed documents. 

This also applies to this PCS 7 readme file.
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Display of PDF files
To read PDF files, you need a PDF reader that is compatible with PDF 1.7 (ISO32000-1:2008 
PDF).

3.2 Form of package

3.2.1 Delivery package
The products listed in the table below are delivered with the required DVD-ROMs for the 
respective product: 

● SIMATIC PCS 7 DVD: 
2 DVDs in a Jewel Case

or

● SIMATIC PCS 7 DVD ASIA: 
2 DVDs in a Jewel Case

● Certificate of License

● The license keys required to operate the software for the supplied product are located on 
the License Key memory stick.

To simplify your license management, you can also save the license keys for other SIMATIC 
PCS 7 products on this memory stick. Authorizations for older SIMATIC products must be 
saved on authorization disks.

3.2.2 Notes on the license contract for the SQL server
The licensee confirms that the software (SW) contains software licensed by the Microsoft 
Corporation (SQL Server) or its subsidiaries. The licensee agrees to be bound by and to abide 
by the terms and conditions of the attached license contract between Microsoft SQL Server 
and end customers.

The Microsoft "SQL-Server" supplied with PCS 7 may not be used outside the PCS 7 
environment without the prior written consent from Siemens.

Notes on Installation
3.2 Form of package
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3.3 Hardware requirements

3.3.1 PC hardware

3.3.1.1 Recommended PC hardware configuration

Recommended basic hardware configuration
We recommend the following configuration for PC components (the higher the quality of the 
equipment, the better):

Parameters Central engineering station with server 
operating system*, Central Archive Server*, 
Information Server, 
PCS 7 OS / SIMATIC BATCH / SIMATIC 
Route Control on a PC, 
Engineering station, 
OS server, 
OS single station, 
Maintenance station, 
PCS 7 Web server, OS client, and BATCH 
client on a PC, 
BATCH server, 
BATCH single station, 
Route Control server, 
Route Control single station

OS client, 
BATCH client, 
Route Control client

Basic PC (see catalog) SIMATIC IPC 847C / 647C / 547D / 547C
Processor min. INTEL Core 2 Duo; >=2.4GHz, INTEL Core 2 Quad 
Work memory (RAM) 4 GB (32-bit operating system)

>=6 GB (64-bit operating system)
2 GB (32-bit operating system)

>=4 GB (64-bit operating system)
Hard disk

Partition size

>=250 GB SATA RAID 1 array in servers and 
ES/OS single stations 

>=250 GB SATA in client systems
C:\ 50GB (Windows Server 2003)
C:\ 100GB (Windows Server 2008)

>=250 GB SATA

C:\ 50GB (Windows XP)
C:\ 100GB (Windows 7)

Network adapter/
communications interfaces 
● For terminal bus 

communication
● For plant bus communication

● RJ45 on-board gigabit Ethernet 
● CP1613 A2 / CP 1623 or BCE network 

adapter for engineering station and OS 
server

● RJ45 on-board gigabit Ethernet

Opt. drive DVD +/-RW DVD-ROM
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Parameters OS client
Basic PC (see catalog) SIMATIC IPC427C
Processor Intel Core2 Duo
Work memory (RAM) 2.0 - 4.0 GB
Hard disk
Partition size

>=250 GB HDD SATA or >=50 GB Solid State disk SATA
C:\ 50GB (Windows XP)
C:\ 100GB (Windows 7)

Network adapter/communications 
interfaces

● 2 x RJ45 on-board Gigabit Ethernet
● without PROFINET or PROFIBUS interface

Special features Without fan
Purpose Approved for OS/Batch client operation only

We recommend the following configuration for Box / Microbox  components (the higher the 
quality of the equipment, the better):

Parameters SIMATIC IPC627C SIMATIC IPC427C
Processor Intel Core i7-610E Prozessor Intel Core2 Duo
Clock-pulse rate 2.53 GHz >=1.2 GHz
Work memory (RAM) 4.0 GB 2.0 - 4.0 GB
Hard disk
Partition size

>=250 GB SATA
C:\ 50GB (Windows XP)
C:\ 100GB (Windows 7)

Compact Flash card: 8.0 GB

Network adapter/
communications interfaces

● 2 x RJ45 on-board Gigabit Ethernet
● on-board CP5611

● 2 x RJ45 on-board Gigabit Ethernet
● on-board CP5611

Opt. drive DVD-ROM -
Special features  Without fan
Purpose SIMATIC IPC627C (BOX PC) is released in 

the context of PCS 7 BOX systems.
PCS 7 AS RTX based on SIMATIC 
IPC427C released only for AS operation.

 
 

 Note

Please note the following:
● In the case of multiproject engineering, it is beneficial for the engineering stations if you 

use PCs with high clock-pulse rates, large main memories and hard disks, and high-speed 
disk drives. In addition to the Microsoft recommendation of "15% free space", we 
recommend that you reserve at least 2 GB of free space (depending on the size of the 
project) on the system partition.

● *: Central engineering station with server operating system (not with Windows Server 2008 
SP2 Standard Edition 32-bit); CAS (Central Archive Server, with Windows Server 2003 
R2 SP2 Standard Edition MUI 32-bit only)

● If the Process Historian and central archive server (CAS with large quantity structure) is 
used in conjunction with large volumes of data, we recommend you use the premium 
server found in the PCS 7 Add-on catalog.
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Additional information 
● Catalog ST PCS 7 for V8.0
● Add on catalog ST PCS 7 for V8.0

3.3.1.2 Compatibility matrix SIMATIC IPC and accessories for PCS 7 V8.0

Compatibility matrix SIMATIC IPC and accessories for PCS 7 V8.0

PCS 7 V8.0 MLFB Windows 7 SP1
Ultimate 32-bit

Windows 7 SP1
Ultimate 64-bit

Windows Server 
2008 SP2

Standard Edition 
32-bit

Windows Server 
2008 R2 SP1 

Standard Edition 
64-bit

RACK IPC      
IPC547B 6ES7650-0N...-.... - - - -
IPC547C 6ES7660-0....-.... X - X -
IPC547D 6ES7660-3....-.... - X - X
IPC647C 6ES7660-1....-.... - X - X
IPC847C 6ES7660-2....-.... - X - X
      
BOX IPC      
IPC627B, BOX 416, 
BOX RTX (RTX 
2008)

6ES7650-2P...-0YX0
6ES7650-2Q...-0YX0

- - - -

IPC627C, BOX with/
without RTX 2010

6ES7650-4A...-.... X - - -

      
Microbox      
IPC427B, AS RTX 
(RTX 2008)

6ES7654-0UE12-0XX0 - - - -

IPC427C, AS RTX 
(RTX 2010)

6ES7654-0UE13-0XX0 - - - -

IPC427C, OS 
clients

6ES7650-0RG..-.... X - - -

      
CPs      
CP1613 A1 6GK1161-3AA00 - - - -
CP1613 A2 6GK1161-3AA01 X X X X
CP1623 6GK1162-3AA00 X X X X
      
Accessories      
Redundant terminal 
bus adapter 
package PCI

6ES7652-0XX01-1XF0 - - - -

Notes on Installation
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PCS 7 V8.0 MLFB Windows 7 SP1
Ultimate 32-bit

Windows 7 SP1
Ultimate 64-bit

Windows Server 
2008 SP2

Standard Edition 
32-bit

Windows Server 
2008 R2 SP1 

Standard Edition 
64-bit

Redundant terminal 
bus adapter 
package PCIe

6ES7652-0XX01-1XF1 X X X X

      
Multi monitor card 
X2 (G450MMS) PCI

6ES7652-0XX03-1XE0 - - - -

Multi monitor card 
X4 (G450MMS) PCI

6ES7652-0XX03-1XE1 - - - -

Multi monitor card 
X2 (M series) PCIe

6ES7652-0XX04-1XE0 X X X X

Multi monitor card 
X4 (M series) PCIe

6ES7652-0XX04-1XE1 X X X X

      
SIMATIC PCS7 
Serial smart card 
reader (OK3111)

6ES7652-0XX11-1XC0 - - - -

SIMATIC PCS7 
USB smart card 
reader (OK3121)

6ES7652-0XX02-1XC0 X *with 
SIMATIC 

Logon

X *with 
SIMATIC 

Logon

X *with 
SIMATIC Logon

X *with 
SIMATIC Logon

      
Signal module, 
PCI card for 
installation in an 
operator station

6DS1916-8RR X X - X

 

PCS 7 V8.0 MLFB Windows XP SP3 
Professional MUI 32-bit

Windows Server 2003 
R2 SP2 

Standard Edition MUI 32-
bit

Windows 
Embedded 

Standard 2009

RACK IPC     
IPC547B 6ES7650-0N...-.... X X -
IPC547C 6ES7660-0....-.... X X -
IPC547D 6ES7660-3....-.... - - -
IPC647C 6ES7660-1....-.... X X -
IPC847C 6ES7660-2....-.... X X -
     
BOX IPC     
IPC627B, BOX 416, 
BOX RTX (RTX 
2008)

6ES7650-2P...-0YX0
6ES7650-2Q...-0YX0

X - -

IPC627C, BOX with/
without RTX 2010

6ES7650-4A...-.... X - -
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PCS 7 V8.0 MLFB Windows XP SP3 
Professional MUI 32-bit

Windows Server 2003 
R2 SP2 

Standard Edition MUI 32-
bit

Windows 
Embedded 

Standard 2009

Microbox     
IPC427B, AS RTX 
(RTX 2008)

6ES7654-0UE12-0XX0 - - X

IPC427C, AS RTX 
(RTX 2010)

6ES7654-0UE13-0XX0 - - X

IPC427C, OS clients 6ES7650-0RG..-.... X - -
     
CPs     
CP1613 A1 6GK1161-3AA00 X X -
CP1613 A2 6GK1161-3AA01 X X -
CP1623 6GK1162-3AA00 X X -
     
Accessories     
Redundant terminal 
bus adapter 
package PCI

6ES7652-0XX01-1XF0 X X -

Redundant terminal 
bus adapter 
package PCIe

6ES7652-0XX01-1XF1 X X -

     
Multi monitor card 
X2 (G450MMS) PCI

6ES7652-0XX03-1XE0 X X -

Multi monitor card 
X4 (G450MMS) PCI

6ES7652-0XX03-1XE1 X X -

Multi monitor card 
X2 (M series) PCIe

6ES7652-0XX04-1XE0 X X -

Multi monitor card 
X4 (M series) PCIe

6ES7652-0XX04-1XE1 X X -

     
SIMATIC PCS7 
Serial smart card 
reader (OK3111)

6ES7652-0XX11-1XC0 X *with WinCC User 
Admin/

SIMATIC Logon

X *with WinCC 
User Admin/

SIMATIC Logon

-

SIMATIC PCS7 
USB smart card 
reader (OK3121)

6ES7652-0XX02-1XC0 X *with WinCC User 
Admin/

SIMATIC Logon

X *with WinCC 
User Admin/

SIMATIC Logon

-

     
Signal module, 
PCI card for 
installation in an 
operator station

6DS1916-8RR X X -

Notes on Installation
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3.3.1.3 Network

Network configuration
The network for the PCS 7 systems must be isolated via switches, routers or gateways in such 
a way that no external interference can affect the PCS 7 network.

You can find recommendations for this in the document:

● Whitepaper; Security Concept PCS 7 and WinCC - Main document

This document can be downloaded from the Customer Support website at: Entry ID 26462131 
(http://support.automation.siemens.com/WW/view/en/26462131) 

3.3.2 AS hardware

3.3.2.1 HW versions

Documentation on hardware
The versions of the AS hardware components that are approved for PCS 7 V8.0 incl. Update 
1 are described in the manual "PCS 7 - Released Modules" section. You can find this document 
on the Internet at SIMATIC PCS 7 Technical Documentation (www.siemens.com/pcs7-
documentation).

CPUs 6ES7414-3EM05-0AB0, 6ES7416-3ER05-0AB0, 6ES7414-3EM06-0AB0 and 
6ES7416-3ES06-0AB0

Time synchronization

● These CPU types can only be synchronized using the NTP method when using the internal 
ETHERNET/PROFINET interface. We recommend that you use the central SICLOCK TC 
400 system clock. For the previous CPU types, we continue to recommend that you use 
the SIMATIC mode.

● You will find notes on SICLOCK TC 400/SICLOCK TM/SICLOCK TS in the function manual 
"PCS 7 – Time synchronization". You can find this document on the Internet at SIMATIC 
PCS 7 Technical Documentation (www.siemens.com/pcs7-documentation).

Restrictions regarding the use of these CPU types
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● The use of these PN/IO CPU types in PCS 7 configurations with a combined plant and 
terminal bus has been approved. Due to NTP time synchronization, a condition for this is 
the use of a SICLOCK central plant clock.

3.4 Installation of the software, software requirements

3.4.1 Software installation

3.4.1.1 Requirements

Released operating systems
The following operating systems are supported in PCS 7 V8.0 incl. Update 1 :

● Windows XP Embedded Standard 2009

● Windows XP Professional SP3 (32Bit)

● Windows Server 2003 SP2 Standard Edition (32Bit)

● Windows Server 2003 R2 SP2 Standard Edition (32Bit)

● Windows 7 Ultimate SP1 (32Bit)

● Windows 7 Ultimate SP1 (64Bit)

● Windows Server 2008 SP2 Standard Edition (32Bit)

● Windows Server 2008 R2 SP1 Standard Edition (64 Bit)

 

Not all configurations are suitable for every operating system. The following table shows the 
relationship of the most common configurations of PCS 7 to the operating systems. Before 
performing the installation, refer to the product-specific readme files to ensure that the product 
being installed is suitable for the desired operating system.

 XP Emb. Std. 
2009

Windows 7 
SP1 (32 Bit) 
XP Prof. SP3 
(32Bit)

Windows 7 
SP1 (64Bit)
 

Server 2003 
SP2 (32Bit)
Server 2003 
R2 SP2 
(32Bit)

2008 Server 
SP2 (32Bit)

2008 Server 
R2 SP1 
(64Bit)

ES  X X X  X
OS- Single Station  X X X  X
ES/OS-Single Station  X X X  X
OS-Server    X X X
OS-Client  X X X X X
Web-Server  X1 X1 X X X
Web-Client  X X X X X
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 XP Emb. Std. 
2009

Windows 7 
SP1 (32 Bit) 
XP Prof. SP3 
(32Bit)

Windows 7 
SP1 (64Bit)
 

Server 2003 
SP2 (32Bit)
Server 2003 
R2 SP2 
(32Bit)

2008 Server 
SP2 (32Bit)

2008 Server 
R2 SP1 
(64Bit)

CAS    X   
Process Historian      X
Information Server  X X X X X
PCS 7 BOX  X X    
PCS 7 RTX  X     
OS-Client Microbox  X     
PCS 7 AS RTX Microbox X      
PCS 7 AS RTX S7 mEC X      

X1 - only on PCS 7 BOX PC (ES or OS single-station system)

Microsoft Internet Explorer
● Only Internet Explorer V7 is allowed for operating systems based on Windows XP and 

Windows Server 2003.

● Only Internet Explorer V8 is allowed for operating systems based on Windows 7 and 
Windows Server 2008.

Microsoft .NET Framework
The Microsoft. NET Framework feature must be enabled prior to the installation of the PCS 7 
software for operating systems based on Windows 7 and Windows Server 2008.

● For Windows 7 under: Control Panel -> Programs and Features -> Turn Windows features 
on or off

● For Windows Server 2008 under: Control Panel -> Programs and Features -> Turn 
Windows features on or off -> Server Manager -> Features

Microsoft SQL Server 
Depending on the product version to be installed, Microsoft SQL Server 2005 Service Pack 4 
and/or Microsoft SQL Server 2008 R2 Service Pack 1 is automatically installed by the PCS 7 
system setup. The computer name must be set before SQL Server is installed. The computer 
name must not be changed afterwards.

Information on installing the operating system based on Windows Server 2003 R2
We recommend you do not enable the optional components of Windows Server 2003 R2. You 
will find the optional components of Windows Server 2003 R2 in the Windows Control Panel 
under Start > Settings > Control Panel > Add/Remove Programs > "Add/Remove Windows 
Components". You will find an overview and additional information on these Windows Server 
2003 R2 options in Microsoft TechNet at 
 Link to the Microsoft TechNet website (http://technet.microsoft.com/en-us/library/
cc785371(WS.10).aspx) 
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Information on installing the operating system based on Windows Server 7 or Windows Server 2008
If the operating system for PCS 7 has not been installed on the PC station yet, reinstall the 
PC. This requires the operating system to be changed. The use of tools such as Windows 
Easy Transfer to transfer data and settings between different operating systems or to perform 
a direct upgrade from Windows Vista to Windows 7 has not been approved.

The use of the following features of the new operating system generation has not been 
approved for PCS 7:

● XP mode (only available with Windows 7)

● HomeGroup (only available with Windows 7)

● Parental Control (only available with Windows 7 Ultimate)

● Windows Defender

● Bit Locker

● Fast User Switching (The use of this feature can be disabled by the administrator via a 
group policy. You can find additional information on the procedure on the SIMATIC PCS 7 
DVD 1/2 in the folder _Manuals\English "PCS 7 - PC Configuration and Authorization.pdf" 
in the section "How to disable user switching")

Using INTEL network adapters
If you use an INTEL network adapter, install the driver located on the "PCS 7 Software Support 
& Tools DVD 2011.01" in the separately available "PCS 7 V8.0 Software Support Package" 
(order number 6ES7650-4XX08-0YT8) under "01_Drivers\NETWORK\Intel
\Intel_LAN_V16.02.49.zip".

Windows Software Update Service (WSUS)
Please note that when you use this service you do not install any software versions deviating 
from the ones described under "Prerequisites for Installation and Operation of the PCS 7 
Software". Such versions include Service Packs for Microsoft operating systems, SQL Server, 
Office or Internet Explorer as well as new versions of Internet Explorer. This guideline does 
not apply to security patches published under the following address: Entry ID 18490004 (http://
support.automation.siemens.com/WW/view/en/18490004).

Permitted domain controllers
● Domain controllers based on Windows Server 2003 SP2 (32-bit) or Windows Server 2003 

R2 SP2 (32-bit)

● Domain controllers based on Windows Server 2008 R2 SP1 (Standard Edition)

Operating system languages
We recommend the following Windows MUI operating systems (Multilingual User Interface) 
with the following languages and corresponding regional settings: 

● German

● English
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● French

● Italian

● Spanish

● Chinese

When you use PCS 7, you will have to set the required language and region at every point in 
the Windows language settings. This affects all the settings available under “Regional and 
Language Options”.

If you use PCS 7 ASIA, make the following settings in the Windows regional and language 
options:

● For the "Language version of the non-Unicode programs“ select "Chinese (PRC)"

● For the "Language used in menus and dialogs", select "English" if you set the language of 
the PCS 7 user interfaces to English.

● For the "Language used in menus and dialogs", select "English" or "Chinese (simplified)" 
if you set the language of the PCS 7 user interfaces to Chinese.

● For the "Standards and formats", select "Chinese (PRC)".

If you change the "Language used in menus and dialogs", the character set may not be 
changed automatically in all cases. We therefore recommend that you go to Control Panel and 
select the "Windows Classic" style under "Display", "Display Properties", "Appearance".

Rules for computer names
The selection of the computer name is critical for the entire project configuration:

● Invalid characters: . , ; : ! ? " ' ^ ´ ` ~ - + = / \ ¦ @ * # $ % & § ° ( ) [ ] { } < > space character, 
hyphen ("-"), underscore ("_")

● Max. 15 characters

● Uppercase letters only

● The first character must be a letter.

It is always advisable that only alphanumeric characters are used for the computer name. You 
should choose a name consisting of uppercase Latin letters (A-Z) and digits (0-9) only, starting 
with a letter and containing a maximum of 15 characters.

Before installing the PCS 7 software
● Message queuing must be installed for PCS 7.

When required, the following Microsoft Patches are installed automatically by the PCS 7 
system setup (depending on the type of installation):

● KB957095 for Windows Server 2003 and Windows XP

● KB929046 and KB925148 for Windows Server 2003

● KB979231 for Windows Server 2008

● KB2483185 for Windows Server 2003, Windows XP and Windows Server 2008
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● KB971468 for Windows Server 2003, see Entry ID 30827420 (http://
support.automation.siemens.com/WW/view/en/30827420)

● KB304718 for Windows Server 2003 (when using Dat@Monitor Server)

● KB907417 for Office 2003 (when using WorkBook and WorkBook Wizard)

● KB908002 for Microsoft .NET Framework 2.0

Security settings
You can find information about the security settings in the "_Manuals\English" folder on the 
SIMATIC PCS 7 DVD 1/2 in the sections "Security settings for the PC configuration" and 
"Firewall" of the "PCS 7 - PC Configuration and Authorization.pdf" file.

Settings need to be made in the registry, the DCOM configuration and the exception list of the 
Windows firewall for the PCS 7 software to operate correctly. 

Before the installation begins, the "Setup - System Settings" dialog appears. There, the system 
settings to be changed are listed. To continue the setup, you need to agree to the change to 
these system settings.

 

 Note

Please note the following:
● The settings must be applied again if the work environment changes (domains, 

workgroups) using the menu command Start > Program Files > Siemens Automation > 
Security Controller > Set Settings . Start the Security Controller (SeCon) after the PC has 
been added to the domain and rebooted. Remember that the Windows services required 
for SeCon are not immediately available after Windows logon. If the tool is started without 
entries, it must be restarted after a brief interval.

● The settings in the exception list of the Windows firewall are applied to the area of the 
local network (subnet). If your PC stations are located in different networks (subnets), you 
need to change this area.

● If you need to make individual changes to any of the firewall settings, they should be 
adapted afterwards.

● If you use the Windows Server 2008 SP2 (32-bit) operating system and install network 
adapters at a later point in time (e.g. install CP-drivers with the setup from SIMATIC NET), 
when you are finished check your custom firewall settings and enter them once again if 
necessary.

● The settings in the exception list of the Windows firewall are made when the Windows 
firewall is disabled.

 

Additional information
Whitepaper; Security Concept PCS 7 and WinCC - Main document
This document can be downloaded from the Customer Support website at: Entry ID 26462131 
(http://support.automation.siemens.com/WW/view/en/26462131) 
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Security patches
For information on the use of current Microsoft security patches, see: Entry ID 18490004 (http://
support.automation.siemens.com/WW/view/en/18490004) 

Please refer to the following FAQ:
SIMATIC WinCC/SIMATIC PCS 7: Information concerning Malware/Virus/Trojan
( Entry ID 43876783 (http://support.automation.siemens.com/WW/view/en/43876783) )

Hyper-Threading Technology
Hyper-Threading has been approved for PCS 7. 

OPC XML DA
OPC XML DA has not been released.

Setting the permissions for restarting the system
When using Windows Server operating systems, users without administrator rights must be 
provided authorization for "System Shutdown".

Without these rights, the system cannot be restarted.

As an administrator, you can set the permission for other user groups using a group policy as 
follows:

1. In the Windows Start menu, open the "Run" dialog box and enter gpedit.msc.

2. In the "Group Policy Object Editor" dialog box, select the folder "Local Computer Policy > 
Computer Configuration > Windows Settings > Security Settings > Local Policies > User 
Rights Assignment."

3. Add the required user groups for the "System Shutdown" object.

Installation of Information Server Client
Before you can install an IS-Client , you need to install the Visual Studio Tools for Office 
(VSTO) . You can find the relevant installation files in the Microsoft Download Center (http://
www.microsoft.com/download/en/details.aspx?id=20479).

3.4.1.2 Notes on installing the software

Updating to V8.0 incl. Update 1
Use the update function for PCS 7 software V7.1.3 or V8.0 already installed (see "Setup Type: 
Install/Update" dialog box).
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Installation
There are two possible ways to install PCS 7:

● Install a previously saved image of the operating system (PCS 7 must not be installed in 
this image). You can then install PCS 7 on this image.

● Install the operating system, and then install PCS 7.

You can find detailed information about the installation requirements and procedure in the 
"PCS 7 - PC Configuration and Authorization.pdf" document located in the "_Manuals\English" 
folder on the SIMATIC PCS 7 DVD 1/2.

Steady state
During the installation of the PCS 7 software, the system must be in steady state. 

Therefore, make sure that no updates are being performed for antivirus software or the 
Windows Software Update Services (WSUS) during the installation. You can ensure this by 
temporarily disabling the corresponding options in each program.

Installation on computers with multi-core processor
When you install the PCS 7 software on PC hardware with multi-core processors in which the 
number of processors is unequal to 2n, you must follow the instructions on the following 
Microsoft Support page: Content ID 954835 (http://support.microsoft.com/kb/954835) 

PC hardware based on SIMATIC IPC recommended for PCS 7 is not affected by this.

Installation on computers with NUMA support
NUMA (Non Uniform Memory Access) is not supported in connection with Microsoft SQL 
Server 2005 on multicore systems. If you use PC hardware which supports NUMA (e.g. FTS 
Primergy) you have to disable this option. 

PC hardware based on SIMATIC IPC recommended for PCS 7 is not affected by this.

Installation via network 
When performing a network installation of PCS 7 on computers with an operating system based 
on Windows 7 and Windows Server 2008, ensure that access is guaranteed to the setup 
procedure, even if the computer reboots during the PCS 7 Setup. There the computer is not 
in a domain, you must enter the sign-in information of the user in order to access the network 
share for the server in the Windows Credential Manager.

3.4.1.3 Notes on updating the software

Updating PCS 7 projects
When updating the software, read the manuals "Software Updates Without Utilization of New 
Functions" or "Software Updates With Utilization of New Functions". These two documents 
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are available at the Internet site "SIMATIC PCS 7 Technical Documentation" 
(www.siemens.com/pcs7-documentation).

The software update of password-protected projects requires SIMATIC Logon on an ES.

Software update with utilization of new functions from the PCS 7 Advanced Process Library 
A software update of the Advanced Process Library (APL) V7.1.x to V8.0x with utilization of 
new functions can only be performed with an AS STOP. 

Updating the PCS 7 Software
If you use the "Update" function in the PCS 7 setup, we recommend you reboot the PC before 
performing the installation.

Before updating SIMATIC NET (on ES and OS servers), the previous version, which is already 
installed, is automatically removed. Following removal, a message will appear prompting you 
to reboot your PC. Reboot the PC. The installation is then automatically continued. 

If you use an INTEL network adapter, install the driver located on the "PCS 7 Software Support 
& Tools DVD 2011.01" in the separately available "PCS 7 V8.0 Software Support Package" 
under "01_Drivers\NETWORK\Intel\Intel_LAN_V16.02.49.zip" .

For PC stations with Windows Server 2003, the driver needs to be installed before the 
installation of SP2 for Windows Server 2003 in order to prevent the loss of the network 
parameters.

3.4.2 MS Windows settings

General information
You can find information about the settings on the SIMATIC PCS 7 DVD 1/2 in the folder 
_Manuals\English in the document "PCS 7 - PC Configuration and Authorization.pdf".

Settings for the Microsoft Internet Information Service (IIS)
The Internet Information Service is a prerequisite for the installation and use of certain PC 
stations (Web server, central archive server, information server). 

You can learn about the settings required to configure the IIS in the documentation for the 
respective product used (e.g. the Web server installation instructions). You also need to read 
the information on configuration of the IIS in the document "PCS 7 PC Configuration and 
Authorization.pdf".

3.4.3 Installation of ES and OS on a single PC
If you wish to install an engineering system (ES) on an existing OS, it is absolutely essential 
to remove the installed PCS 7 OS version first and then perform the "Engineering Station" 
installation.
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3.4.4 Installation of SIMATIC NET products

Installation of the SIMATIC NET product
SIMATIC NET is a product which always has to be installed by the system setup for PCS 7.

Installation of the SIMATIC NET SOFTNET-IE RNA V8.1 product
The separately available product, SIMATIC NET SOFTNET-IE RNA V8.1, is suitable for the 
following operating systems:

 Windows XP 
Emb. Std. 
2009

XP Prof. SP3 
(32Bit)

Windows 7 
SP1 (32 Bit)
Windows 7 
SP1 (64Bit)
 

Server 2003 
SP2 (32Bit)
Server 2003 
R2 SP2 (32Bit)

2008 Server 
SP2 (32Bit)

2008 Server 
R2 SP1 (64Bit)

SIMATIC NET 
SOFTNET-IE RNA 
V8.1

  X   X

See also entry ID 57989518 (http://support.automation.siemens.com/WW/view/en/57989518) 

3.4.5 Use of the Media Redundancy Protocol (MPR) for PROFINET fieldbus

Network topologies
It is absolutely necessary to operate the PROFINET fieldbus ring with MRP (Media 
Redundancy Protocol) when using rings with PROFINET. The HSR (High Speed Redundancy) 
protocol and MRP cannot be used simultaneously in the same ring. The PROFINET fieldbus 
ring may only consist of devices that support MRP functionality.

The following Industrial Ethernet switches support the MRP function:

● SCALANCE X-200 as of Firmware-Version V4.0

● SCALANCE X-200 IRT as of Firmware-Version V4.0

● SCALANCE X-300 as of Firmware-Version V3.0

● SCALANCE X-400 as of Firmware-Version V3.0

 HSR 
High Speed Redundancy

MRP
Media Redundancy Protocol

Separate terminal and plant bus X -
Common terminal and plant bus X -
PROFINET fieldbus - X
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Configuration of the watchdog time
In the event of a transmission line failure, reconfiguration of the network (switching to the 
redundant transmission line) can take up to 200 ms.

Increase the watchdog time for each station by: 

● Selecting the "Fixed update time" setting

● Increasing the update time to a value that is smaller than the fastest update of the process 
image partition (PIP) for this station

● Increasing the number of accepted update cycles with missing I/O data, so that the 
watchdog time is > 200 ms

See also entry ID 46636225 (http://support.automation.siemens.com/WW/view/en/46636225) 

3.4.6 Settings for standard network adapters (BCE and Softnet)

3.4.6.1 Plant bus with TCP/IP protocol
Make the following settings for the plant bus:

● Disable "File and printer sharing"

● Disable "Client for Microsoft network"

● Enable the ISO protocol

Please refer to the information in the PCS 7 Engineering System Configuration Manual, PCS 
7 Operator Station Configuration Manual and the WinCC Information System: "Special aspects 
of communication in a server with multiple network adapters".

3.4.6.2 BCE and time synchronization
When synchronizing the time via BCE, select the following settings: 

● 1 - 10 sec. intervals on the external time transmitter.

● The ISO protocol be installed and enabled for the network adapter.

● Only a network adapter (BCE) can be used for time synchronization on an OS.

● The settings and notes for the CP 1613 are otherwise relevant for time synchronization.

● When using time synchronization with BCE/CP 1612, the following destination address 
multicast must be used: address 09-00-06-01-FF-EF.

● Broadcast may not be used.
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3.4.7 Installation of SIMATIC BATCH products

Note on the software updates for BATCH servers
Prior to the software update of PCS 7 V7.1 SP3 (with SIMATIC BATCH V7.1 SPx) to PCS 7 
V8.0 incl. Update 1 (with BATCH V8.0.x), you need to set the BATCH Launch Coordinator to 
the "Manual" start mode.

3.4.8 Installation of older versions of PCS 7 libraries
If you install or remove an older version of the PCS 7 Library, PCS 7 Basis Library or PCS 7 
Advanced Process Library following the installation of PCS 7 V8.0 incl. Update 1 , you must 
re-install the latest versions of PCS 7 Basis Library or PCS 7 Advanced Process Library via 
the PCS 7 system setup afterwards. Do not use the product setup of these libraries to do this. 
This relates, for example, to PCS 7 Library V6.1+SP1+Upd17, PCS 7 Basis Library V7.1 SP3 
+ Upd6 and PCS 7 Advanced Process Library V7.1 SP5 + Upd3, which are located in the 
Additional_Products folder of SIMATIC PCS 7 DVD 2/2.

 

3.4.9 Using antivirus software and whitelisting protection mechanisms

Approved antivirus software
An overview of the approved virus scanners for each version of the software is available in the 
Internet at Entry ID 2334224 (http://support.automation.siemens.com/WW/view/en/2334224).

You can find additional documents about the PCS 7 and WinCC security concept in the Internet 
at Safety concept entry list (http://support.automation.siemens.com/WW/view/en/
35231330/130000).

The following antivirus software has been tested for compatibility with PCS 7 V8.0 incl. Update 
1 and can be installed subsequently:

● Trend Micro OfficeScan Client-Server Suite V10.6

● Symantec Endpoint Protection V11.0 (if you are using a 64-bit operating system, we 
recommend that you use a version as of 11.0.7000.975)

● McAfee VirusScan Enterprise V8.8 Patch 1 + Hotfix 735512

Using Whitelisting protection mechanisms
Existing anti-malware protection for PC systems, from anti-virus programs for example, can 
be effectively supplemented with Whitelisting protection mechanisms. 

Whitelisting mechanisms provide additional protection for the installation of PC systems by 
prohibiting the execution of unauthorized software or modification of installed applications. 

Additional security applications are installed to enable such protection. 
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The following Whitelisting  software has been tested for compatibility with PCS 7 V8.0 incl. 
Update 1:

● McAfee Application Control V5.1

You can find more information about "Whitelisting protection mechanisms" on the Internet at 
the Customer Support web page: Content ID 49382928 (http://
support.automation.siemens.com/WW/view/en/49382928).

3.4.10 Use of Multi-VGA graphics cards
The following graphics cards and drivers are recommended for PC stations in PCS 7:

 Windows XP (32-bit) Windows 7 (32-bit)
Windows Server 2008 
(32-bit)

Windows 7 (64-bit)
Windows Server 2008 
R2 (64-bit)

G450 MMS
● Order number: 

6ES7652-0XX03-1XE0 
(2 monitors)

● Order number: 
6ES7652-0XX03-1XE1 
(4 monitors)

XP2K_596_005.exe - -

M9120 Plus LP PCIe x16 
(widescreen resolution 
possible)
● Order number: 

6ES7652-0XX04-1XE0

xddm32_210_00_105
_se_u_whql.exe

wddm32_401_00_105
_whql.exe

wddm64_401_00_105
_whql.exe

M9140 LP PCIe x16 
(widescreen resolution 
possible)
● Order number: 

6ES7652-0XX04-1XE1

xddm32_210_00_105
_se_u_whql.exe

wddm32_401_00_105
_whql.exe

wddm64_401_00_105
_whql.exe

 

You can find the drivers on the "PCS 7 Software Support & Tools DVD 2011.01" in the 
separately available "PCS 7 V8.0 Software Support Package" (order number 
6ES7650-4XX08-0YT8) in the folder "01_Drivers\DISPLAY".

Detailed information is available on the SIMATIC PCS 7 DVD 1/2 in the folder _Manuals
\English in chapter "How to activate a multi-VGA graphics card" of document "PCS 7 PC 
Configuration and Authorization".

3.4.11 Using a DCF 77 client
Install the latest version V2.00 when using the DCF 77 client service. It is available on the 
"PCS 7 Software Support & Tools DVD 2011.01" in the separately available "PCS 7 V8.0 
Software Support Package" (order number 6ES7650-4XX08-0YT8) in the folder 
"02_Timesynchronization\DCF77Client_V2.00".
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Install "DCF 77 Client V2.00" with the default settings of the setup program.

3.4.12 Shutting down Windows, standby mode / hibernation
Whenever you shut down Windows on your PCS 7 computers, use the command "Start > 
Shutdown Computer" and then select "Shutdown" or "Restart". 
Do not use "standby mode" and "idle state".

3.4.13 SIMATIC Logon

SIMATIC Logon
The term "SIMATIC Logon Admin Tool" has been replaced by "SIMATIC Logon Role 
Management".

Note on the use of smart cards
 Make sure that you reformat all smart cards that were formatted with SIMATIC Logon prior to 
V1.3. This is necessary because SIMATIC Logon uses improved encryption for smart cards 
as of version V1.3. If you attempt to logon with a smart card that is not updated, the attempt 
will fail. You can always logon with your name and password, however.
If you remove a smart card being used to log on during configuration in the SIMATIC Logon 
role management, all changes you have made up to this point and not saved will be discarded. 
Reinserting the card will not solve this problem.

Notes on the Windows workgroup 
If you require increased availability, you need to work in a domain environment, since no 
redundancy is offered by SIMATIC Logon in a Windows workgroup.

Notes on the SIMATIC Logon Event Log Viewer
If you want to print the events in the event log, proceed as follows:

● Click "Export" and export the events in PDF format.

● Print out the exported file.

Instead of the file size of the event log, the number of recorded events is displayed based on 
the configured filter.

The filter dialog always shows the date and time based on the settings you have selected for 
the date and time in Windows. Display in conformity to ISO 8601 is not possible.
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3.4.14 Using smart card readers
When using the USB smart card reader or the serial smart card reader, use the drivers provided 
on the "PCS 7 Software Support & Tools DVD 2011.01" in the separately available "PCS 7 
V8.0 Software Support Package" (order number 6ES7650-4XX08-0YT8) in the folder 
"01_Drivers\CHIPCARD".

Logon with SIMATIC Logon:

 Windows XP (32-bit)
Windows 2003 (32-bit)

Windows 7 (32-bit)
Windows 2008 (32-bit)

Windows 7 (64-bit)
Windows 2008 R2 (64-bit)

OMNIKEY CardMan 3111 CardMan3111_V1_1_2_1.e
xe

- -

OMNIKEY CardMan 3121 USB OMNIKEY3x21_V1_2_6_5.
exe

OMNIKEY3x21_V1_2_6_5.
exe

OMNIKEY3x21_V1_2_6_5_
x64.exe

 

Logon without SIMATIC Logon:
The use of the WinCC User Administrator control and monitoring stations together with a smart 
card reader has only been approved for Windows XP / 2003.

 Windows XP (32-bit)
Windows 2003 (32-bit)

Windows 7 (32-bit / 64-bit)
Windows 2008 (32-bit)
Windows 2008 R2 (64-bit)

OMNIKEY CardMan 3111 Install both drivers:
● CardMan3111_V1_1_2_1.exe
● CT-API_V4_0_2_2.exe

-

OMNIKEY CardMan 3121 USB Install both drivers:
● OMNIKEY3x21_V1_2_6_5.exe
● CT-API_V4_0_2_2.exe

-
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3.4.15 Using Microsoft Office
The following Office products have been tested for compatibility with PCS 7 V8.0 incl. Update 
1:

 Operating systems based on
Windows XP
Windows Server 2003

Operating systems based on
Windows 7
Windows Server 2008

Microsoft Office 2003 SP3
(Excel, Word, Access and 
PowerPoint)

X  

Microsoft Office Professional 2007 
SP3 32-bit 
(Excel, Word, Access and 
PowerPoint)

X X

Microsoft Office Professional 2010 
SP1 32-bit 
(Excel, Word, Access and 
PowerPoint)

X X

Word Viewer 2003 SP3 X X
Excel Viewer 2007 SP2 X X
PowerPoint Viewer 2010 X X

 

The Microsoft Office applications Word, Excel, and Access can be used in process mode on 
PCS 7 OS and BATCH clients. However, their use may result in significantly reduced 
performance in some situations. Office must not be used in process mode on any other 
operator stations and BATCH stations.

Microsoft Office must be installed prior to PCS 7.

You can find more information about the compatibility of SIMATIC PCS 7 on the Internet at 
the Customer Support website: 

● Entry ID 2334224 (http://support.automation.siemens.com/WW/view/en/2334224)

3.4.16 Ethernet settings
Make sure there are no inconsistencies in Ethernet CPs, switches and network adapters in 
terms of their settings/properties for data transmission rate and bus access procedure.

We recommend using the default Autonegotiation setting (procedure for the automatic 
negotiation of the best transmission mode between two network interfaces which are directly 
connected to one another).

You can find information in the section "How to change the transmission rate and operating 
mode in the PC network" of the document "PCS 7 - PC Configuration and Authorization.pdf" 
located on the SIMATIC PCS 7 DVD 1/2 in the folder _Manuals\English.
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3.4.17 Changing the storage location for projects/multiprojects
The project path in "Storage location for projects/multi-projects" is set by default to "SIEMENS
\STEP7\S7Proj" and all necessary access rights are set for this project path.

If you use another project path, you need to set the necessary access rights using the 
"SimaticRights.exe" tool.

To do this, start the "SimaticRights.exe" program on the SIMATIC PCS 7 DVD 2/2 in the folder 
"Additional_Products\SimaticRights". Enter the new project path or select it in the dialog. The 
new project path must be available when the tool starts.

3.4.18 Remote service and remote operation

VNC
As of PCS 7 V8.0, the "RealVNC" Enterprise Edition V4.6.3 software is approved for operation 
for remote service access.

You can find more information about the use of "RealVNC" in PCS 7 plants in the Internet at 
the Customer Support web page: Content ID 55422236 (http://
support.automation.siemens.com/WW/view/en/55422236) 

3.4.19 Modifying the internal authentication mechanism of the OS

General information
Starting with PCS 7 V7.1 SP3, the PCS 7 OS works with a modified internal authentication 
mechanism. Certain security settings will be modified accordingly on the SQL Server and in 
the project databases. These changes are carried out automatically during installation and 
when you initially open an OS project.

Install a copy of PCS 7 as of V7.1 SP3 on all OS stations of your plant so that all components 
of your OS system operate with the modified authentication function.

Launch the "SIMATIC Rights" tool with administrator privileges immediately on completion of 
this installation. The tool is available in the "Additional_Products\SimaticRights\" folder on your 
SIMATIC PCS 7 DVD 2/2. Run the tool with double-click on "SimaticRights.exe". Select the 
path that contains your STEP 7, PCS 7, or WinCC project folders from the "Storage location". 
Confirm with "OK". Run the tool for all paths that contain STEP 7, PCS 7, or WinCC projects.

All users must have been assigned to the "SIMATIC HMI" user group. This rule also applies 
users who want to open the OS projects remotely. Access by members of the "SIMATIC HMI" 
user group to the OS database has been restricted to the necessary minimum authorizations 
(read/write). Unrestricted access to the OS database is granted as usual only to users who 
have Windows administrator privileges. 

Add users who only need read access to the OS database to the "SIMATIC HMI VIEWER" 
group.
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Members of the Windows user group "SIMATIC HMI" should not also be members of the 
Windows user group "SQLServer2005MSSQLUser$<Computername>$WINCC".

Members of this user group have administrator privileges on the SQL Server. Remove all 
Windows users who only need restricted access to the OS database from this group.

The user "SA" (System Administrator) of the SQL Server is deactivated during installation.

The "WinCCAdmin" and "WinCCConnect" user names have been removed from the OS 
database in order to improve access security. These user names can no longer be used to 
access the OS database. Application using their own SQL user name and password are not 
affected by this change.

Modified authorizations for access to system information
Following the installation of PCS 7 as of V7.1 SP3, users with standard Windows user rights 
are denied access to specific system information. This concerns in particular the following 
system information of the WinCC channel "System Info": 

- CPU load

- Status of the swap file

Assign all users who need this system information to the Windows group "System monitor 
users".

Restrictions for access to ODK functions
The following ODK functions are no longer available to users with standard Windows 
authorization: 

- CreateDatabase 

- DatabaseAttach

- DatabaseDetach

3.4.20 Remote access to OS projects
All users must have been assigned to the "SIMATIC HMI" user group. This rule also applies 
users who want to open the WinCC projects remotely. Check in particular the following users:

● Users who want to connect a Connectivity Pack Client to a Connectivity Pack Server. These 
users must be registered members of the "SIMATIC HMI" group on the Connectivity Pack 
Server.

● Users accessing the Web center of DataMonitor.
1.) If you set up a connection to the OS database, you require an additional Windows user 
and password. Assign this user the necessary authorizations for access to the OS 
database. For this purpose, set up a separate Windows user on the server and assign this 
user to the "SIMATIC HMI Viewer" Windows group.
2.) To enable access to a remote computer from the DataMonitor server, the Windows user 
and the same password must have been set up on the DataMonitor server and relevant 
remote servers. Register this user and the password in the connection administration of 
the Web center. For this purpose, proceed as specified at item 1.).
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3.4.21 Installation of WinAC software
You can find the software for WinAC controllers on the "PCS 7 Software Support & Tools DVD 
2011.01" in the separately available "PCS 7 V8.0 Software Support Package" (order number 
6ES7650-4XX08-0YT8) under "03_WINAC_RTX__V4.6+Upd1\DVD__V4.6".

The latest corrected versions are available for download under entry ID 15227402 (http://
support.automation.siemens.com/WW/view/en/15227402).

3.5 Licensing

3.5.1 PCS 7 licenses and quantity structures
An overview of the PCS 7 licensing concept and the associated quantity structures for licensing 
is available in the document "Process Control System PCS 7; Licenses and configuration 
limits". 

You can find this document in the Internet at SIMATIC PCS 7 Technical Documentation 
(www.siemens.com/pcs7-documentation).

 

3.5.2 Managing AS runtime licenses
In order for the licenses to be available in sufficient quantities following the activation of the 
license check, we recommend keeping these licenses on the engineering station from where 
the controller usually loads them.

 

 Note
Installation of the AS RT PO licenses

Please select the appropriate AS RT PO license installation for your engineering environment:
1. AS RT PO license installed on the local engineering PC

Install the AS RT PO license(s) in sufficient numbers on the engineering PC. The favorites 
list in the Automation License Manager (see menu "File > Settings") must not contain 
entries or the PCs listed do not have AS RT PO licenses.

2. AS RT PO license installed on a license server
Install the AS RT PO license(s) in sufficient number  on the license server PC. The favorites 
list in the Automation License Manager (see menu "File > Settings") must contain the 
name of the license server PC.  The local engineering PC must not have an AS RT PO 
license.
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Notes on Usage 4
4.1 AS (Automation system)

4.1.1 AS default setting for PCS 7 projects
See Configuration manual Process Control System PCS 7; Engineering System

4.1.2 Switching times for H CPU in connection with a fail-safe application
If you load F modules, you must select the monitoring time of each F sub-assembly as longer 
than the switching time of the active channel in the H system. Notes on the upper limit of this 
changeover time can be found in the manual S7 F-FH Systems - Configuring and Programming 
in section "A.6".
Run, F-monitoring, and response times: 
A table with formulas for calculating the upper limit is available on the Internet at: SIMATIC S7 
F/FH systems entry list (http://support.automation.siemens.com/WW/view/en/
13711209/133100) 

If you do not follow this instruction, F modules may malfunction when the active channel is 
switched.

See also the Safety Engineering System Manual in SIMATIC S7

Entry ID 12490443 (http://support.automation.siemens.com/WW/view/en/12490443) 

4.1.3 ET 200S

4.1.3.1 ET 200S diagnostics of load voltage failure
The digital input/output modules of the ET 200S have no diagnostics in the event of load voltage 
failure. This means that when the load voltage supply fails on the channel drivers, no QBAD 
is reported. When there is no voltage supply, outputs can no longer be switched via the 
application program and the last available value is indicated on inputs. 

You can manage with the following configuration:

● Use DI, DO modules with 24 VDC with power module PM-E DC 24 V: 
6ES7 138-4CA00-0AA0
By supplying the entire station (IM151 and power modules) from a common 24 VDC source, 
a failure in the voltage supply causes a station failure. This is reported in PCS 7 and causes 
passivation of all the modules involved, i.e. all channel drivers are set to QBAD.

● Use of DI, DO modules with 120/230 VAC with power module PM-E AC 120/230 V: 6ES7 
138-4CB10-0AB0: applicative monitoring of load voltage in an application program
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4.1.3.2 ET 200S counter module 6ES7138-4DA04-0AB0
When using the counter module in an ET 200S, the interface module higher than or equal to 
6ES7 151-1BA01-0AB0 must be used.

4.1.4 Using S7 PLCSIM
Simple application tests can be carried out with PLCSIM without the availability of AS hardware. 

The project should be adapted as follows:

1. If the AS-OS connection is "NamedConnection" (PCS 7 Standard): compile OS "Change" 
and change connection to network type "Industrial Ethernet."

2. Start PLCSim from the SIMATIC Manager.

3. Load HW Config.

4. Set PG/PC interface in PLCSIM and PLCSIM(ISO).

5. Load charts / programs.

6. Set PLCSIM to operating mode "RUN".

7. SIMATIC Manager: in the Project -> OS -> "Start OS Simulation" or "Open Object" and then 
"activate".

 

 Note

After using PLCSIM, it may be necessary to re-establish the real connection and recompile 
the changes made to relevant AS including the real connection to the OS.

OS connections with a simulated WinAC Controller (WinLC RTX or WinAC Slot) are not 
possible. See the notes on simulation of a WinAC Controller in the PLCSIM Readme.

 

4.1.5 Voltage failure on ET 200iSP
In the event a DP slave loses voltage, the voltage loss is reported along with the removal of 
the first modules after the head module of the slave. The later message is irrelevant.

4.1.6 Changing the address range of HART modules in ET 200iSP/ET 200M leads to 
address displacements

If HART auxiliary variables are configured retrospectively for HART modules, this leads to an 
enlargement of the address field required for these modules. The I/O field may therefore be 
redefined. The CiR capability is lost due to this. Note that your project may need to be adapted 
(symbol tables, CFC charts). 

We recommend setting up the modules with a CiR element in the address range of the HART 
auxiliary variables during configuration. This ensures that the max. address range is used and 
avoids address displacement.
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4.1.7 Fast Mode functionality for HART devices 
● Update 6ES7 33?-?TF01-0AB0 firmware to V3.x

Download firmware:

– 331-7TF01-0AB0: 
Entry ID 33273268 (http://support.automation.siemens.com/WW/view/en/33273268)

– 332-8TF01-0AB0: 
Entry ID 32011516 (http://support.automation.siemens.com/WW/view/en/32011516)

● Replace modules 6ES7 33?-?TF00-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x

– To activate HART-Fast-Mode, you will have to replace the HART module in HW Config 
(6ES7 33?-?TF00-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x).

– Then delete the HART field devices and renew the configuration.

– Then activate "HART-Fast-Mode" in the module configuration and "HART RIO SHC 
Mode" in the PDM settings.

● Replace modules 6ES7 33?-?TF01-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x

– To activate HART-Fast-Mode, you will have to replace the HART module in HW Config 
(6ES7 33?-?TF01-0AB0 with 6ES7 33?-?TF01-0AB0 V3.x).

– Then activate "HART-Fast-Mode" in the module configuration and "HART RIO SHC 
Mode" in the PDM settings.

● Redundant modules
HART-Fast-Mode is not possible for redundantly configured modules.

4.1.8 Configuration in RUN with FM350-1, FM350-2, FM355, FM355-2, CP 341 
The modules FM 350-1, FM350-2, FM355, FM355-2 and CP 341 are CiR-compliant, which 
means they can be added or removed via CiR (hot-swapped) when the AS is in RUN.

Note the following information about these modules when performing Configuration in Run:

● FM 350-1 and FM350-2, CP 341:
Changing the module parameters with CiR when the CPU is in RUN resets the module and 
is equivalent to restarting the module.

● FM 355 and FM355-2:
Bumpless changes to module parameters for individual channels are possible to some 
extent using CiR when the CPU is in RUN, refer to the documentation of the FM modules.

4.1.9 Time synchronization with central plant clock SICLOCK
The limitation of max. 50 NTP-request/sec as stated in the "PCS 7 – Time synchronization" 
function manual applies only to the old central plant clock SICLOCK TM. This limitation does 
not apply to the new central plant clock SICLOCK TC 400 when using the NTP process.
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4.1.10 Firewall on the plant bus
You will find information on this in the manual "PCS 7 – PC Configuration and 
Authorization.pdf".

4.1.11 ET 200pro
The use of ET 200pro with CP 443-5 Extended is only approved with the 
6GK7 443-5DX04-0XE0 module, firmware version V6.4 or later.

The modules from the ET 200pro series must be configured in DPV1 mode in HW Config. In 
DPV0 mode, no interrupts are sent to the PCS 7 driver blocks.

4.1.12 Isochronous mode in PCS 7
PCS 7 does not support isochronous mode.

4.1.13 Fault-tolerant connections via internal ETHERNET/PROFINET interface
S7-400 H as of firmware V6.0 supports fault-tolerant connections via your internal ETHERNET/
PROFINET interface. 

The redundant IE coupling via Simatic PC stations required for this available beginning with 
SimaticNet V8.1 SP1 on operating systems based on Windows 7 and Windows Server 2008.

If you would like to use fault-tolerant AS-AS connections via the internal interface of the V6.0 
H-CPU, you need to be aware that the connections to the communication partner can only be 
configured via the internal interface of the V6.0 H-CPU or CP443-1 EX30.

4.1.14 Using PROFINET

Shared Device
The use of PROFINET Shared Device with PCS 7 V8.0 including Update 1 is not supported.

Assigning device numbers
Only device numbers up to 255 are supported by the driver generator in the PROFINET IO 
system.

CIR functionality 
If you would like to use the CIR functionality on the PROFIBUS master system for S7-400 PN/
DP CPU with firmware <= V6.0.2 (6ES7414-3EM06-0AB0 and 6ES7416-3ES06-0AB0), you 
cannot configure PROFIBUS and PROFINET I/O simultaneously for the internal interfaces.
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Reporting module errors
With PROFINET IO, modules errors (e.g. no external auxiliary voltage) are reported by OB82 
with a general error message. To obtain detailed diagnostic information, you must use HW 
Config Online Diagnostics for the given module.

4.1.15 Using HART auxiliary variables with 4 F-AI HART modules
The configured HART auxiliary variables of the following module are not supported by the PCS 
7 channel blocks:

● 4 F-AI HART (order number 6ES7 138-7FA00-0AB0)

You can obtain additional information in the operating instructions "ET200iSP Distributed I/O 
Device - Fail-safe Modules" under entry ID 47357221 (http://support.automation.siemens.com/
WW/view/en/47357221).

4.2 ES (Engineering System)

4.2.1 Client engineering
Opening clients on the ES can in some circumstances take a very long time, since it involves 
an implicit update of all server data (packages). Operator input to the SIMATIC Manager is not 
possible during this time.

4.2.2 Notes of configuration in RUN
Changes can be made to the distributed I/O of an S7-400 AS configuration during ongoing 
operation; these are described in the following documents:

Method System configuration Documentation
CiR 
Configuration in Run

Standard automation system 
CPU 414-3, 416-x, 417-4
Fault-tolerant automation system in 
1v1 mode

PCS 7 – Configuration Manual for 
Engineering System; Using CiR to 
make changes to the configuration 
during operation 

H-CiR 
Configuration in Run

Fault-tolerant automation system 
CPU 412-3H, 414-4H, 417-4H

Automation system S7-400H
Fault-tolerant systems, Section 11

4.2.3 Settings when using two or more network adapters
If multiple standard network adapters are used (for example, INTEL desktop adapter), the 
adapter for the terminal bus must appear first in the list. (Network Properties: "Advanced > 
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Advanced Settings"). Any non-functioning network adapters which are inserted must be 
disabled.

Following a PCS 7 installation, a dialog appears in which you have to select the network 
adapter for the terminal bus. If an adapter is selected, confirm it with "OK" and then confirm 
the "Reinitialize" dialog with "Yes".

4.2.4 CFC/SFC: Downloading to the AS
Programs created with CFC/SFC may only be downloaded with the following functions:

● In CFC/SFC with menu command "PLC > Download"

● In SIMATIC Manager (component view), select the project or station and then the menu 
command "PLC > Compile and Download Objects"

● In the SIMATIC Manager (component view), select charts and then the menu command 
"PLC > Download".

Only the loading function of the CFC/SFC guarantees that the engineering data will be 
consistent with the PLC data. Downloading changes to the CFC/SFC in the RUN mode of the 
S7 CPU is only possible when the download is performed exclusively with these functions.

4.2.5 Compiling CFC charts after software update
During compilation, the number of components installed in a flow unit is checked and a warning 
message issued when an configurable limit is exceeded. This may lead to this warning 
appearing after a software update during compilation, even though no error has occurred. This 
warning message can be disabled by adapting the limit accordingly or suppressing the warning 
message (see CFC online help).

4.2.6 Special characters for the nomenclature
Only certain characters are allowed in names, depending on the language and components. 
It is not recommended to use national special characters.

Special restrictions:

● A comma "," in tag names (process tags, archive tags etc.) is generally not allowed.

● The project name, picture name, and computer name may not contain multibyte characters 
(e.g. Chinese).
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For other naming conventions for projects, refer to:
● "Engineering System Configuration Manual"

● WinCC Online Help, using the search term "Invalid characters"

● C:\Program Files\SIEMENS\WINCC\Documents\English\Projects.pdf

4.2.7 Notes on exporting SNMP variables with access-protected PCS 7 projects
Note that you first have to open the WinCC project in SIMATIC Manager for projects with 
activated FDA access protection if you want to export WinCC variables. 

Additional information on exporting SNMP variables, for example, for the PCS 7 Maintenance 
Station, is available in the manual "PCS 7 – Operator Station Configuration Manual", section 
"15.15.1 How to export SNMP variables".

4.2.8 Compiling and downloading S7 connections – downloading to an AS
If connections are to be downloaded to an AS via "PLC > Compile and Download Objects", 
the connections of all connection partners are compiled and loaded. Connection partners here 
are also all the AS that have a configured connection to the same OS as the AS to be 
downloaded. When downloading the connection data to the respective AS, there is a temporary 
break in the connection between AS and OS or between the AS with AS-AS communication.

4.2.9 Download
When a "Download" performed from an ES to an OS, the Windows user logged on to the ES 
must be known on the target station and a member in one of the following groups there: At 
least "Superuser", "SIMATIC HMI" "SIMATIC NET", "SIMATIC Batch" and required SIMATIC 
Route Control "RC_..." groups. In addition, the user also needs full access rights for the folder 
into which the project should be downloaded. This includes the sharing and security settings.
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4.2.10 Notes on cross AS interconnections
● When using cross AS interconnections, the S7 program names in the multiproject must be 

different.

● Hardware requirements:

– S7-400 CPU with firmware version higher than/equal to V3.1

– Communications processor higher than/equal to 443-1EX10 V2.1.

– The compact stations PCS 7 BOX RTX and PCS 7 BOX 416 cannot be used for AS-
wide interconnections.
Use the blocks of the PCS 7 Library V7.1 + SP3 for AS-AS communication. You can 
find this library on DVD 2/2 in the folder "Additional_Products
\PCS7LIBRARY__V7.1+SP3".

● If there is an overload on the S7-400 CPU or if there are network disruptions, the following 
messages can appear: "Overload sender: S7 connection ID xxxx". This means that a data 
transfer cycle could not be executed. The data will be transferred in the next cycle.

4.2.11 F-monitoring time of F modules and F field devices after Y Link/DP-PA Link 
By extending the calculation of the monitoring times for updating the reserve, it is possible as 
of PCS 7 V7.1 SP1 to consider F-monitoring times of F modules and F field devices after Y 
Link/DP-PA Link.

 

 NOTICE

When you activate the option "Calculate F modules after Y Link" you will change the CRC 
for the F module configuration. You will have to compile the F program once again.

You may have to adjust the F monitoring times of the affected F modules and F field devices 
prior to the calculation.

Use the Excel file s7ftime to determine the F monitoring times for F modules after Y Link and 
F field devices on PROFIBUS-PA.

SIMATIC S7 F systems: execution times of fail-safe blocks, runtime of F shutdown group, 
monitoring and reaction times. 

Internet: Entry ID 22557362 (http://support.automation.siemens.com/WW/view/en/
22557362) 

 

 

4.2.12 Use of F modules in connection with SIMATIC PDM
In order to configure the following fail-safe modules in conjunction with SIMATIC PDM V8.0.x, 
use SIMATIC PDM >= V8.0 + Upd1, a SIMATIC PDM Device Library as of 1#2012 and S7 F 
ConfigurationPack >= V5.5 SP9 + Upd1: 
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● ET 200M F AI 6x HART
Order number: 6ES7 336-4GE00-0AB0

● ET 200iSP 4 F-AI Ex HART (iSP)
Order number: 6ES7 138-7FA00-0AB0

● ET 200iSP 8 F-DI Ex Namur (iSP)
Order number: 6ES7 138-7FN00-0AB0

● ET 200iSP 4 F-DO Ex 40 mA (iSP)
Order number: 6ES7 138-7FD00-0AB0

You can download the latest version of SIMATIC PDM Device Library from the SIMATIC PDM 
Web page (https://www.siemens.com/simatic-pdm). 

4.2.13 Configuration of fail-safe modules in ET200M PROFINET stations
In order to operate fail-safe applications on PROFINET, the following requirements must be 
met:

● All configured devices and the employed F-drivers must support PROFIsafe V2 mode

● The employed version of S7 F Configuration Pack must be later than V5.5 SP9 + Upd1

Note the following before the first compilation of the hardware configuration:

● For the fail-safe operation on PROFINET, be sure to use only fail-safe modules that are 
listed in the "PCS 7 V8.0" module filter under PROFINET IO -> I/O -> ET200M.

● Be sure to use a version >= V1.3 of the F-system library in your project. If you have not yet 
used F-blocks in your project, place at least one F-block from the F-library version >= V1.3 
within a CFC (for example, F-channel drivers).

4.2.14 Merging projects after distributed editing (multiproject engineering)
If you merge projects into a multiproject, you have to execute the following menu command: 
"File > Save as... > With Reorganization".

4.2.15 Updating SFC blocks to use new functionality in SIMATIC BATCH
For SFC types/instances, the "Restart" command is now supported in the interface to SIMATIC 
BATCH .

For this extension to be available, the block @SFC_BZL (FB 245) must be copied from the 
SFC Library to the block folder of all programs and a complete compilation and a download of 
changes must then be carried out.

In addition to updating the  FB 245, the procedure described in the SIMATIC BATCH readme 
file as of version V7.1 SP1 Hotfix 8 must be followed in order to use the extended functionality.
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4.3 PCS 7 libraries

4.3.1 Diagnostic alarms for digital input modules SM 321-7BH00 and SM 321-7BH01

Diagnostic evaluation for channel-based diagnostic interrupts of the module 
When using digital input modules SM 321-7BH00 and SM 321-7BH01, the diagnostic 
evaluation for a channel-based diagnostic interrupt is performed in channel groups. 

When using digital input module SM 321-7BH01 HF, the channel-related diagnostic interrupt 
takes place for each individual channel.

Diagnostic option: Missing encoder supply 
SM 321-7BH00 and SM 321-7BH01

● Digital input channels 0 to 7 are combined into channel group 0.

● Digital input channels 8 to 15 are combined into channel group 1.

Eight alarms are output for each channel group if the encoder supply is missing. 

● "Error channel 00" .... "Error channel 07" or

● "Error channel 08" .... "Error channel 15"

Diagnostic option: Wire break
For SM 321-7BH01 only 

● Digital input channels 0 and 1 are combined into channel group 0.

● Digital input channels 2 and 3 are combined into channel group 1.
.
.

● Digital input channels 12 and 13 are combined into channel group 6.

● Digital input channels 14 and 15 are combined into channel group 7.

The channel involved can therefore not be clearly identified in the text of the diagnostic interrupt/
diagnostic message.

4.3.2 Redundant I/O
During a software update from PCS 7 V7.1 SP3 to PCS 7 V8.0 incl. Update 1 (with new 
functions), new blocks are imported into the project from the "Redundant IO CGP V52" library, 
if redundant I/O is used. For blocks from the RedLib V3.x and V4.x, this software update is 
only possible via AS STOP.

The blocks that you use are in the "Redundant IO CGP V52" library.

You will find more information on the redundant I/O in the following manuals:

Notes on Usage
4.3 PCS 7 libraries

PCS 7 Readme V8.0 including Update 1
46 Readme, 07/2012, A5E03759369-03



● PCS 7 - Function Manual Software Update with Utilization of the New Functions

● PCS 7 - Function Manual Fault-tolerant Process Control Systems

● Manual Automation System S7-400H; Fault-Tolerant Systems

Value status of driver blocks is not supported in redundancy operation of 6ES7 
321-7TH00-0AB0 module.

4.3.3 Using the S7 F Configuration Pack
When you upgrade without utilization of the new functions and then install the S7 F 
ConfigurationPack V5.5 SP4 or higher at a later time, you will have to repeat the installation 
of the PCS 7 libraries to receive consistent data for the driver generator.

Library installed prior to installation of S7 F 
ConfigurationPack >= V5.5 SP4

Library has to be installed again

PCS 7 Library V6.x PCS 7 Library V6.x (>= V6.1.1.17)
PCS 7 Library V7.0.x PCS 7 Library 7.0.x (>= V7.0.2.10)

 

4.3.4 Using the PCS 7 Advanced Process Library V8.0 + Upd1 and software update for 
PCS 7 V8.0 including Update 1

A software update to PCS 7 V8.0 incl. Update 1 with utilization of new functions requires an 
AS stop and a complete compilation if you are using V7.1.x of the PCS 7 Advanced Process 
Library (APL) in your project. 

You can find additional information in the readme file PCS 7 Advanced Process Library V8.0 
+ Upd1.

4.3.5 Note on software updates using new functions
Please note that in case of a software update with the use of new functions you will have to 
delete blocks that may be present in your project or master data library of the PCS7 standard 
library (OB_DIAG, OR_M_16 and OR_M_32) and that are no longer used before you add the 
new library blocks. Use the CFC function "Clean project" for this purpose.
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4.4 OS (Operator control and monitoring System)

4.4.1 OS-specific information and notes on installation and use
You will find PCS 7 OS-specific information and notes on installation and use of this component 
in the readme file of the product.

4.4.2 Customized user programs
If you create your own applications, system tests in the relevant environment are necessary 
to ensure the stability of the entire system.

4.4.3 Starting process mode on the OS server
● Process mode will not be started on an OS server if this server is not connected to the 

network.

● Please note that when you start process mode on a redundant server, the first server takes 
over process mode completely before the redundant partner is started. No client should be 
active before process mode is started on a server for the first time. The OS clients can then 
be activated.

4.4.4 Deactivating a redundant OS server
Before deactivating a redundant server, ensure that the partner server is in an state that is 
fault-free and operational (for example, there are no process coupling faults). Archive 
synchronization must be competed before deactivation, which can be recognized with the 
corresponding process control message.

4.4.5 Fixed TCP/IP address for 16x3
If a DHCP server cannot be located at the process bus, then a TCP/IP address from the APIPA 
(Automatic Private IP Addressing) band 169.254.x.x will be set.

 

 Note

If a LAN cable is connected to a PC station and the associated LAN partner is not available 
in the network or is switched off, you cannot activate automatic switchover using Setup. If 
you turn on the LAN partner after the frame setup of the LAN partners, you will see the 
message "Limited or no connectivity" after starting the PC station. Manually assign a TCP/IP 
address for the network card (CP 1613/1623) to avoid this message.
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4.4.6 OS change download

Procedure for extensive changes
If an AS has been added, a redundancy switchover and entries in the message system may 
occur when changes are download.  The following procedure is recommended when extensive 
changes are involved: Configure the changes in single steps ("packet-by-packet") on the ES 
and then transfer them to the OS in individual "packets".

Changes to tags with access to an OPC-DA-Client application
It may happen in the course of configuration that tags are deleted from a project that are 
requested at this time by an OPC-DA-Client application using a Subscription . Restoration of 
these tags in the project will not automatically initiate an update of the tags by means of OPC. 
Provided the tags in question are available in an OS server project and the OPC DA server is 
running on an OS client or OpenPCS 7 station, it is sufficient to initiate a redundancy switchover 
of the corresponding OS server project to trigger an update of the tags. Otherwise, the OPC-
DA-Client application needs to re-register the tags in question.

4.4.7 Setting access permissions in the operating system
A PCS 7 OS automatically sets the "SIMATIC HMI" local user group following installation under 
Windows. The currently logged on user and local administrator are registered in this user 
group. Enter the users who should have access to PCS 7 OS in the  "SIMATIC HMI" group 
with their logon information.

You can find additional information in the WinCC Information System under "Installation Notes 
> Installation Requirements > Setting Access Permissions in the Operating System" and in the 
document "PCS 7 - PC Configuration and Authorization.pdf" located in the _Manuals\English 
folder on the SIMATIC PCS 7 DVD 1/2 .

Observe the notes in section Modifying the internal authentication mechanism of the OS 
(Page 34).

All Window users who work with PCS 7-, PCS 7 OS or Route Control projects must also be 
members of the "SIMATIC NET" group.

4.4.8 Controls
Using controls from third-party suppliers may lead to errors such as performance problems or 
system blockage. The user of the software must assume responsibility if problems are caused 
by third-party controls. We highly recommend that you run a system test to ensure safe 
operation before putting them into use.
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4.4.9 User interface and design
In PCS 7, you can choose between the following settings for the appearance of the user 
interface in process mode:

● Design "WinCC 3D"

● The WinCC designs "Classic", "Glass" and "Simple" are not supported by PCS 7.

Note the following:

● Make sure that there is a uniform setting for the design for all the projects of a plant.

● If you change the setting for the WinCC design, check the appearance of objects you have 
created yourself and adapt them if necessary.

● Retain the setting if you update the software. During a software update, changing the setting 
for the appearance of the user interface in process mode could cause considerable 
changes.

4.4.10 Delaying the transfer of archives
If a redundant partner is not available or is deactivated, the transfer of the archives of the 
redundant partner will be delayed. The transfer of archives is started or continued only when 
the partner becomes available again and synchronization of the archives is completed.

Since the storage capacity of the ring buffer for Tag Logging and Alarm Logging is limited, 
there is a risk of data loss if the redundant partner is out of action for a longer period of time.

4.4.11 Disabling / enabling messages using the WinCC Alarmcontrol
The disabling / enabling messages functionality using WinCC Alarmcontrol has not been 
approved for PCS 7.

4.4.12 WinCC archive configuration tool
The WinCC archive configuration tool is an Excel add-in that helps you create Tag Logging 
archives quickly and easily. It is possible to handle volumes for which the Tag Logging Editor 
offers insufficient support. A prerequisite is a Microsoft Excel installation. A detailed description 
is available in the WinCC Information System under "Smart Tools\WinCC Archive 
ConfigurationTool".

To perform the installation, start the setup on the SIMATIC PCS 7 DVD 1/2 under: 
"WinCC_Options\WinCC_ArchiveTool__V7.0+SP3\setup"
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4.4.13 OS server for Process Historian in the WinCC service mode
If you wish to automatically start an OS Server for Process Historian in WinCC service mode 
when the computer boots, you need to adapt the auto-start settings when using Windows 
Server 2008 R2 SP1 64-bit.

Select the start type setting "Automatic (Delayed Start)" for the "CCCAPHServer" service.

4.4.14 Updating the diagnostics OS
The diagnostics OS must be compiled with the "Entire OS" option following a software update 
from PCS 7 V8.0 to PCS 7 V8.0 incl. Update 1. This enables process control messages to be 
displayed correctly in ASSET-PC faceplates.

4.5 SIMATIC BATCH

4.5.1 Compiling and loading BATCH with the "Compile and Download Objects" function
Note that when you modifying projects, compiling and loading should always be performed in 
the following sequence: AS, OS, BATCH.

4.5.2 API interface
If you are a user of a SIMATIC BATCH V6.0 API interface software, you need to recompile 
your application for the V8.0 interface. If you are a user of SIMATIC BATCH V6.1 + SP1 (or 
higher) API interface software, you do not have to recompile your application. The two 
interfaces are compatible.

4.5.3 Access permissions
The following sharing is set for SIMATIC BATCH during the installation:

● BATCH

The PCS 7 software manages the share permissions automatically. 

4.5.4 Common server for PCS 7 OS and SIMATIC BATCH
A redundant server can be used at same time as a common server for PCS 7 OS and SIMATIC 
BATCH.

Notes on Usage
4.5 SIMATIC BATCH

PCS 7 Readme V8.0 including Update 1
Readme, 07/2012, A5E03759369-03 51



4.5.5 Settings for Report Service
If you use a single-user station with SIMATIC Batch under the Windows XP operating system, 
you have to adapt the settings for the SIMATIC Batch Report Service to display the print 
preview.

Set port 8080 for the Report Service in the Logging section of the project settings in the Batch 
Control Center (BCC).

4.6 SIMATIC PDM

Using the Device Integration Manager
Once you have installed SIMATIC PDM, you are prompted to import the devices you are using 
onto the computer. Run the "Device Integration Manager" program for this. 

After an update installation from PCS 7 V7.1 SP3 to PCS 7 V8.0 incl. Update 1, you will need 
to re-import the "Device Library".

You must install the program "htmlhelp.exe" so that the "Device Integration Manager" can 
generate the device-specific online help. This program is available in the "Additional_Products
\MS_HTML_HelpGen_for_PDM" folder on your SIMATIC PCS 7 DVD 2/2.

User calibration of the S7-300 analog modules with PDM V8.0
User calibration of the following module in combination with SIMATIC PDM V8.0 is temporarily 
not possible:

● SM 331 AI6xTC
Order number: 6ES7 331-7PE10-0AB0

To use the user calibration of the following modules in conjunction with SIMATIC PDM V8.0 
+ Upd1, you need to useSIMATIC PDM Device Library as of 1#2012:

● SM 331 AI8x16Bit HART
Order number: 6ES7 331-7TF01-0AB0

● SM 331 AO8x16Bit HART
Order number: 6ES7 331-8TF01-0AB0

The devices supported by PDM are included on the supplied "Device Library". You can 
download the latest version from the SIMATIC PDM Web page (https://www.siemens.com/
simatic-pdm).

Canceling the module redundancy for HART modules of ET 200M and ET200iSP remote IOs
In order to cancel the module redundancy set in the hardware configuration (HWC), you need 
to adhere to the following procedure:

1. Delete the module in question and then compile the hardware project

2. Remove the deleted module from the process device plant view or network view

3. Configure the module again in HWC
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This ensures that the redundancy is removed correctly.

Note on project migration to PDM V8.0
When migrating a PDM project from a previous version to PDM V8.0.x, it is absolutely 
necessary to do the following: 

● Install all add-on packages used in the project before you open the project for the first time.

4.7 Central archive server/StoragePlus
 

 Note

There must be sufficient free hard disk space on the central archive server. The “Archives” 
folder must contain at least twice the memory required for the sum of all the configured 
individual OS segments.

 

The central archive server is only released for the Windows Server 2003 (Standard Edition) + 
SP2 or Windows Server 2003 R2 (Standard Edition) + SP2 operating system.

Installation requirements:

● StoragePlus: Windows XP SP3, Windows Server 2003 (Standard Edition) + SP2 or 
Windows Server 2003 R2 (Standard Edition) + SP2

● Central archive server: Windows Server 2003 (Standard Edition) + SP2 or Windows Server 
2003 R2 (Standard Edition) + SP2

● Microsoft Internet Information Services (IIS) and installed Message Queuing

● With Windows Server 2003 (Standard Edition) + SP2 or Windows Server 2003 R2 
(Standard Edition) + SP2, the server function "Application Server (IIS, ASP.net)" must be 
enabled. Information on this is available in the document "PCS 7 - PC Configuration and 
Authorization.pdf" on the SIMATIC PCS 7 DVD in the folder "_Manuals\English".

Microsoft components for central archive server/StoragePlus
The Microsoft components for CAS and StoragePlus will be installed automatically by the PCS 
7 system setup as of PCS 7 V7.1.

Install the Central Archive Server or StoragePlus from the SIMATIC PCS 7 DVD with the 
appropriate installation package.

If a redundant OS server pair with connected central archive server/StoragePlus is completely 
deactivated, on reactivation, the server deactivated last must be activated first.

If the project is connected to a central archive server or if there is no link to the connected OS 
servers, a message will appear on these OS servers indicating that there are problems with 
the connection to the central archive server. The message can be confirmed by clicking "OK"; 
otherwise the notice closes automatically when the connection to the central archive server is 
activated or returns.
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Web Viewer: Filtering alarms
The standard filter in the "Filter" dialog box can only be used with certain restrictions in the 
Web Viewer in the "Display alarm as table" function. The input boxes for user text, process 
value and process text cannot be used, otherwise the filter results in an empty table.

Archive segmentation of local OS server / CAS
If the start time of the archive segments of the local OS servers is older than the start time in 
CAS, it is only possible to navigate as far as the start time of the CAS segments. We therefore 
recommend that you select the ring buffer for CAS several times larger.

The monthly segment change may only be set with a start date of 1 to 28.

Software update
Before you update the CAS software (SW update installation), you must disconnect any *.SPB 
(StoragePlus Backup) databases that may be connected to the project. The databases are 
checked and disconnected using the StoragePlus Administration Console (SPB databases 
originate in CAS/Storage Plus PCS 7 < V7.0 or prior to/equal to V1.1.1).

Note:

If you still need the values archived in the SPB databases for display, you must to reconnect 
these SPB databases after the update. 

You may see an error message during the update: 

"Error while disconnecting backup databases from SQL Server!"

You can ignore this message if there are no SPB databases connected with the project, and 
confirm with "OK".

4.8 PCS 7 Web server
Information about the PCS 7 Web add-on package is available in the "PCS 7 - Web OS Option" 
manual. You can find this document on the Internet at SIMATIC PCS 7 Technical 
Documentation (www.siemens.com/pcs7-documentation).

You can find additional information, for example, on "Configuring a Web Project", in the "WinCC 
Web Navigator Information System".

4.9 Data Monitor

Operating and monitoring WEB
The "Process Screen" function is no longer used for operator control and monitoring via WEB 
in DataMonitor. Instead, the "WinCCViewerRT" Web viewer can be used on the DataMonitor 
client. 

For more information, please see the "DataMonitor Release Notes".
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Restrictions on usage of the DataMonitor server
Always use the DataMonitor server on a computer that is not operated in WinCC ServiceMode.

4.10 OpenPCS 7

Evaluation of "Active Time"
"Active Time" cannot be used for evaluations with Historical Alarm&Event.

Project languages
If you have project languages other than Western European Languages (code page Windows 
– 1252), an OPC A&E Client may only use the languages “German” or “English”, as offered 
by the OpenPCS 7 OPC server. 

Changes to tags with access to an OPC-DA-Client application 
Observe the section OS change download (Page 49).

Changing the storage location for LastAcknowledgedEventFiles
The storage location for the LastAcknowledgedEventFiles has changed. The previous storage 
location "C:\Program Files\Common Files\Siemens\SCI\Bin\LastAcknEventID"  was moved to 
"C:\Document and Settings\AllUsers\Application Data\Siemens\SCI\LastAcknEventID" due to 
new user rights. During a migration from PCS 7 V7.1 SP3 to PCS 7 V8.0 incl. Update 1, you 
transfer files (*.dat) that have already been created to this new storage location.

Downloading the OpenPCS 7  station
Following installation or update of OpenPCS 7, you need to perform a "Download" of the 
OpenPCS 7 station on the engineering station.

4.11 Redundant systems
PCS 7 as of V7.1 SP2 contains advanced self-diagnostics for redundant software systems 
(servers). If this diagnostics routine detects an internal fault, if the redundant partner server is 
fully functioning, all communication connections on the server affected by the fault are 
disconnected (terminal and system bus). 
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Example:
● WinCC und BATCH Server are running on server (A) .

● The full function of the redundant partner server (B) is achieved when WinCC and BATCH 
Server are running on server (B) and the runtime data of WinCC and BATCH are 
synchronized.

Automatic restart of the affected server is only performed when this full functionality is achieved.

Requirements
● Use of a PCS 7 OS (multi-station) redundant system, SIMATIC BATCH and SIMATIC Route 

Control.

● You must make the following configuration settings on the server systems:

– Automatic Windows logon (not relevant for servers in WinCC service mode)

– Automatic start of the PCS 7 server applications

● Deactivate the "Display Shutdown Event Tracker".
Proceed as follows: 
Call via Start > Run...: Enter "gpedit.msc"
In the "Group Policy" dialog: Select Computer Configuration > Administrative Templates > 
System and open the properties of the "Display Shutdown Event Tracker". Select 
"Disabled".

● Before a PCS 7 server application is exited, an availability check is carried out on the 
relevant redundant partner server. The aspect of the data synchronization is not taken into 
account in the availability check.
If the partner server is not fully functional, the user is informed of this status and can proceed 
accordingly.
The availability check is only carried out in service mode if a user is logged on.

Configuring automatic Windows logon
You can use one of the two available methods for configuring automatic Windows logon:

● How can I set up auto logon for SIMATIC PCs? See Entry ID 23598260 (http://
support.automation.siemens.com/WW/view/en/23598260) (only for operating systems 
based on Windows XP or Windows Server 2003)

● Autologon for Windows v3.01 (http://technet.microsoft.com/en-en/sysinternals/bb963905)
(all operating systems)

Additional information
You will find more detailed information in the corresponding application descriptions (manual 
and readme for PCS 7 OS, SIMATIC BATCH, SIMATIC Route Control, SIMATIC NET).

Notes on Usage
4.11 Redundant systems

PCS 7 Readme V8.0 including Update 1
56 Readme, 07/2012, A5E03759369-03

http://support.automation.siemens.com/WW/view/en/23598260
http://support.automation.siemens.com/WW/view/en/23598260
http://technet.microsoft.com/en-en/sysinternals/bb963905


4.12 SIMATIC NET

SIMATIC NET SOFTNET IE RNA
The following restrictions regarding the quantity structure for the operator station apply to the 
use of the Parallel Redundancy Protocol (PRP) on the redundant terminal bus:

 Maximum number
OS servers / server pairs 8
OS clients in multi-client operation (per multiple-
station system)

12

Process objects / process tags per OS server 2,000 PO
Process objects / process tags per multiple-station 
system

16,000 PO

Long term archive tags 17,000
Messages per second per server 2

 

For more information, see the function manual "Fault-tolerant Process Control Systems"

This document is available on the Internet at "SIMATIC PCS 7 Technical Documentation" 
(www.siemens.com/pcs7-documentation).

SCALANCE X204RNA
You may only use devices from the SCALANCE X204RNA product series to connect the 
following devices to the redundant terminal bus with PRP functionality:

● Infrastructure computer (e.g. domain controller, DNS, WINS, DHCP server or file server)

● Master system clock SICLOCK TC400

S7-RedConnect based on TCP/IP
Be aware of the following restrictions when using S7-RedConnect based on TCP/IP:

● CP 1623 supports 60 S7-RedConnect TCP/IP connections per PC 

● CP 1613 is not supported
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Software components on the SIMATIC PCS 7 DVD 
V8.0 including Update 1 and changes to PCS 7 V8.0 5
SIMATIC PCS 7 DVD 
SW components

PCS 7 V8.0 PCS 7 V8.0 incl. Update 1

_Product Information   
Automation License Manager V5.1 + SP1 + Upd1 V5.1 + SP1 + Upd3
STEP 7 Basis V5.5 + SP2 V5.5 + SP2 + Upd1
CFC V8.0 V8.0 + Upd1
S7-SCL V5.3 + SP6 V5.3 + SP6
SFC V8.0 V8.0
TH V8.0 V8.0 + Upd1
IEA-PO V8.0 V8.0 + Upd1
PCS 7 Basis Library V8.0 V8.0 + Upd2
PCS 7 Advanced Process Library V8.0 V8.0 + Upd1
VersionCrossManager V7.1 + SP3 V7.1 + SP3
Version Trail V8.0 V8.0
PCS 7 PID Tuner V8.0 V8.0
DOCPRO V5.4 + SP2 V5.4 + SP2
PLCSIM V5.4 + SP5 + Upd1 V5.4 + SP5 + Upd1
SIMATIC WinCC V7.0 + SP3 V7.0 + SP3 + Upd1
WebNavigator V7.0 + SP3 V7.0 + SP3 + Upd1
DataMonitor V7.0 + SP3 V7.0 + SP3 + Upd1
StoragePlus V7.0 + SP3 V7.0 + SP3 + Upd1
Process Historian V8.0 V8.0 + Upd1
Information Server V8.0 V8.0 + Upd1
OpenPCS 7 V8.0 V8.0 + Upd2
SFC Visualization V8.0 V8.0
AS-OS-Engineering V8.0 V8.0 + Upd1
PV InsInfo Server V8.0 V8.0
PCS 7 Basis Faceplates V8.0 V8.0 + Upd1
PCS 7 Advanced Faceplates V8.0 V8.0 + Upd1
SIMATIC NET PCSW V7.1 + SP4

V8.1 + SP1
V7.1 + SP5
V8.1 + SP2

SIMATIC BATCH V8.0 V8.0 + Upd1
SIMATIC BATCH BLOCKS V8.0 V8.0 + Upd1
SIMATIC Logon V1.5 V1.5 + Upd1
SIMATIC PDM V8.0 V8.0 + Upd1
SIMATIC PDM Devices Internet download:

https://www.siemens.com/simatic-pdm
Internet download:
https://www.siemens.com/simatic-pdm

SIMATIC Route Control V8.0 V8.0 + Upd1
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SIMATIC PCS 7 DVD 
SW components

PCS 7 V8.0 PCS 7 V8.0 incl. Update 1

PCS 7 System Documentation V8.0 V8.0
PCS 7 Tools V8.0 V8.0 + Upd1
SQL Server 2005 SP4

2008 R2 SP1
2005 SP4
2008 R2 SP1

   
WinCC_Options : DVD 1/2 DVD 1/2
WinCC Archive Configuration Tool V7.0 + SP3 V7.0 + SP3
WinCC_Fileserver V7.0 + SP3 V7.0 + SP3
WinCC_WebNavigator V7.0 + SP3 V7.0 + SP3
   
Additional_Products : DVD 2/2 DVD 2/2
ACC_integration   
BATCH Report See 

BATCH_Report__V7.0+SP1+HF15.txt
See 
BATCH_Report__V7.0+SP1+HF15.txt

DiagMonitor V4.3 + SP1 + HF2 V4.3 + SP3
MS_HTML_HelpGen_for_PDM 4.74.8703 4.74.8703
PCS 7 Advanced Process Library V7.1 + SP5 + Upd2 V7.1 + SP5 + Upd3
PCS 7 Basis Library V7.1 + SP3 + Upd5 V7.1 + SP3 + Upd6
PCS 7 Faceplates V7.1 + SP3 V7.1 + SP3
PCS 7 Library  

V7.1 + SP3
V6.1 + SP1 + HF17
V7.1 + SP3

S7 Block Privacy V1.0 + SP1 + Upd1 V1.0 + SP1 + Upd1
Simatic Diagnose Tool (SDT) Download link SDT_2011_1
SimaticRights   
   
Sonstiges :   
PKZIP V12.4 V12.4
DotNetFramework V2.0 SP2, V3.0 SP2, V3.5 SP1, V4.0 V2.0 SP2, V3.0 SP2, V3.5 SP1, V4.0
   

.NET Framework
On the subject of .NET Framework, see also: 
"With what is SIMATIC PCS 7 compatible?; section Notes on using Microsoft .NET on PCS 7 
stations "
Entry ID 2334224 (http://support.automation.siemens.com/WW/view/en/2334224) 

S7-F Systems
S7 F Systems V6.0 (only for the Windows XP Professional SP3 and Windows Server 2003 
operating systems) and V6.1 SP1 have been tested for compatibility with PCS 7 V8.0 incl. 
Update 1. 
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You can find additional information on F systems on the Internet at:
 Entry ID 16537972 (http://support.automation.siemens.com/WW/view/en/16537972) 

For S7 F systems, use S7 F ConfigurationPack >= V5.5 SP9 + Upd1.
You can find more information about the F Configuration Pack on the Internet at:
 Entry ID 15208817 (http://support.automation.siemens.com/WW/view/en/15208817) 

SIMATIC Safety Matrix
SIMATIC Safety Matrix V6.1 (only for the Windows XP Professional SP3 and Windows Server 
2003 operating systems) and V6.2 SP1 have been tested for compatibility with PCS 7 V8.0 
incl. Update 1.

Please read carefully the section "Changing to S7 F Systems V6.1" in the "S7 F-FH Systems 
- Configuring and Programming" manual.

SIMATIC IPC DiagMonitor
DiagMonitor V4.3 + SP3 has been tested with PCS 7 V8.0 incl. Update 1 for compatibility.

Run the following files on the SIMATIC PCS 7 DVD 2/2 under Additional_Products > 
DiagMonitor__V4.3+SP3 to perform the installation:

● For 32-bit operating systems:

– Folder x86\DiagMonitor > DiagMonitor_Silent_Install.bat

– Folder x86\DiagMonitor > CM_Activate.exe

● For 64-bit operating systems:

– Folder x64\DiagMonitor > DiagMonitor_Silent_Install.bat

– Folder x64\DiagMonitor > CM_Activate.exe

You can find additional information on the installation and the approved types of computers in 
the "GettingStarted.pdf" document in the respective installation folder.

Software components on the SIMATIC PCS 7 DVD V8.0 including Update 1 and changes to PCS 7 V8.0

PCS 7 Readme V8.0 including Update 1
Readme, 07/2012, A5E03759369-03 61

http://support.automation.siemens.com/WW/view/en/16537972
http://support.automation.siemens.com/WW/view/en/15208817



	Legal information - Warning notice system
	 Table of contents
	1 Security information
	2 Overview
	3 Notes on Installation
	3.1 General information
	3.2 Form of package
	3.2.1 Delivery package
	3.2.2 Notes on the license contract for the SQL server

	3.3 Hardware requirements
	3.3.1 PC hardware
	3.3.1.1 Recommended PC hardware configuration
	3.3.1.2 Compatibility matrix SIMATIC IPC and accessories for PCS 7 V8.0
	3.3.1.3 Network

	3.3.2 AS hardware
	3.3.2.1 HW versions


	3.4 Installation of the software, software requirements
	3.4.1 Software installation
	3.4.1.1 Requirements
	3.4.1.2 Notes on installing the software
	3.4.1.3 Notes on updating the software

	3.4.2 MS Windows settings
	3.4.3 Installation of ES and OS on a single PC
	3.4.4 Installation of SIMATIC NET products
	3.4.5 Use of the Media Redundancy Protocol (MPR) for PROFINET fieldbus
	3.4.6 Settings for standard network adapters (BCE and Softnet)
	3.4.6.1 Plant bus with TCP/IP protocol
	3.4.6.2 BCE and time synchronization

	3.4.7 Installation of SIMATIC BATCH products
	3.4.8 Installation of older versions of PCS 7 libraries
	3.4.9 Using antivirus software and whitelisting protection mechanisms
	3.4.10 Use of Multi-VGA graphics cards
	3.4.11 Using a DCF 77 client
	3.4.12 Shutting down Windows, standby mode / hibernation
	3.4.13 SIMATIC Logon
	3.4.14 Using smart card readers
	3.4.15 Using Microsoft Office
	3.4.16 Ethernet settings
	3.4.17 Changing the storage location for projects/multiprojects
	3.4.18 Remote service and remote operation
	3.4.19 Modifying the internal authentication mechanism of the OS
	3.4.20 Remote access to OS projects
	3.4.21 Installation of WinAC software

	3.5 Licensing
	3.5.1 PCS 7 licenses and quantity structures
	3.5.2 Managing AS runtime licenses


	4 Notes on Usage
	4.1 AS (Automation system)
	4.1.1 AS default setting for PCS 7 projects
	4.1.2 Switching times for H CPU in connection with a fail-safe application
	4.1.3 ET 200S
	4.1.3.1 ET 200S diagnostics of load voltage failure
	4.1.3.2 ET 200S counter module 6ES7138-4DA04-0AB0

	4.1.4 Using S7 PLCSIM
	4.1.5 Voltage failure on ET 200iSP
	4.1.6 Changing the address range of HART modules in ET 200iSP/ET 200M leads to address displacements
	4.1.7 Fast Mode functionality for HART devices 
	4.1.8 Configuration in RUN with FM350-1, FM350-2, FM355, FM355-2, CP 341 
	4.1.9 Time synchronization with central plant clock SICLOCK
	4.1.10 Firewall on the plant bus
	4.1.11 ET 200pro
	4.1.12 Isochronous mode in PCS 7
	4.1.13 Fault-tolerant connections via internal ETHERNET/PROFINET interface
	4.1.14 Using PROFINET
	4.1.15 Using HART auxiliary variables with 4 F-AI HART modules

	4.2 ES (Engineering System)
	4.2.1 Client engineering
	4.2.2 Notes of configuration in RUN
	4.2.3 Settings when using two or more network adapters
	4.2.4 CFC/SFC: Downloading to the AS
	4.2.5 Compiling CFC charts after software update
	4.2.6 Special characters for the nomenclature
	4.2.7 Notes on exporting SNMP variables with access-protected PCS 7 projects
	4.2.8 Compiling and downloading S7 connections – downloading to an AS
	4.2.9 Download
	4.2.10 Notes on cross AS interconnections
	4.2.11 F-monitoring time of F modules and F field devices after Y Link/DP-PA Link 
	4.2.12 Use of F modules in connection with SIMATIC PDM
	4.2.13 Configuration of fail-safe modules in ET200M PROFINET stations
	4.2.14 Merging projects after distributed editing (multiproject engineering)
	4.2.15 Updating SFC blocks to use new functionality in SIMATIC BATCH

	4.3 PCS 7 libraries
	4.3.1 Diagnostic alarms for digital input modules SM 321-7BH00 and SM 321-7BH01
	4.3.2 Redundant I/O
	4.3.3 Using the S7 F Configuration Pack
	4.3.4 Using the PCS 7 Advanced Process Library V8.0 + Upd1 and software update for PCS 7 V8.0 including Update 1
	4.3.5 Note on software updates using new functions

	4.4 OS (Operator control and monitoring System)
	4.4.1 OS-specific information and notes on installation and use
	4.4.2 Customized user programs
	4.4.3 Starting process mode on the OS server
	4.4.4 Deactivating a redundant OS server
	4.4.5 Fixed TCP/IP address for 16x3
	4.4.6 OS change download
	4.4.7 Setting access permissions in the operating system
	4.4.8 Controls
	4.4.9 User interface and design
	4.4.10 Delaying the transfer of archives
	4.4.11 Disabling / enabling messages using the WinCC Alarmcontrol
	4.4.12 WinCC archive configuration tool
	4.4.13 OS server for Process Historian in the WinCC service mode
	4.4.14 Updating the diagnostics OS

	4.5 SIMATIC BATCH
	4.5.1 Compiling and loading BATCH with the "Compile and Download Objects" function
	4.5.2 API interface
	4.5.3 Access permissions
	4.5.4 Common server for PCS 7 OS and SIMATIC BATCH
	4.5.5 Settings for Report Service

	4.6 SIMATIC PDM
	4.7 Central archive server/StoragePlus
	4.8 PCS 7 Web server
	4.9 Data Monitor
	4.10 OpenPCS 7
	4.11 Redundant systems
	4.12 SIMATIC NET

	5 Software components on the SIMATIC PCS 7 DVD V8.0 including Update 1 and changes to PCS 7 V8.0

